XTrackCAD Guide d’utilisation Ed 2011

Introduction a I'interface utilisateur

1. ECRAN RESEAU

Apres démarrage de XTrkCad et aprés avoir cliqué sur le conseil du jour ("Tip of the Day") vous
verrez I’écran ainsi:
'r:*."n'n'.é'i'ﬂ' ‘rackplan - XTrkCad(4.0.1)

File Edit View Add Change Draw Manage Options Macro Window Help
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2. GENERALITES

La Fenétre Principale comprend (de haut en bas):

Barre de titres — Nom du fichier actuel, numéro de version XTrkCad, and et bouton de gestion
de fenétre. Un astérisque (*) apres le nom de fichier indique que des modifications effectuées
n’ont pas encore €t sauvegardées.

F4 cascade.xic - XTrkcad(4.0.1)

Barres des menus — boutons: File, Edit, View, Add, Change, Draw, Manage, Options, Macro,
Window et Help.

File Edit View Add Change Draw Manage Options Macro Window Help
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Barre d’outils — manipuler les voies et autres objets a 1I’écran

@@ (2] 5]z

A | ) 4 P 9 e 0 ] S PN [ Y
BERAAEREEEEEID

Barre objets — liste déroulante des voies et structures

N e T H'

Plan principal — la zone principale du plan avec des régles de chaque coté
|I5:1 [0 [39.000 [34.250  [[23.125 11.000] is not a track i

Barre d’état — comprend (de gauche a droite)

échelle du plan,
nombre total de voies (pas toujours visible)
position en X du curseur (souris)

position en Y du curseur (souris)

A e

messages d’état et d’informations

En réduisant la Fenétre principale on réduit toute le fenétre XTrkCad.

Le Plan principal est la zone ou les voies et autres objets sont tracés.

L’échelle du Plan principal peut étre changée en utilisant les sélections Zoom sous le menu
déroulant View ou les boutons Zoom de la Barre d’outils. 11 est aussi possible de changer

d’échelle avec la molette de la souris.

Les voies sont tracées avec une ou deux lignes selon 1’échelle et avec les traverses en grossissant
le zoom. A I’échelle 1 :1, I’axe des voies est également tracé.

Vous pouvez changer la portion de plan affichée en utilisant la fenétre Map.

les touches PAGE UP et PAGE DOWN permettent également le zoom + ou -. Les touches
FLECHES permettent de bouger la fenétre du Plan.
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3. MAIN PRINCIPAL

Description rapide du menu principal:

File: ouvrir, enregistrer, imprimer les réseaux et gestion des fichiers de paramétres

Edit: Sélection, désélection, copier et coller, édition des propriétés telles que épaisseur ou
portion de tunnel

View: Zoom + et -, affichage d’une grille et régénération d’écran

Add: Placer de nouveaux ¢léments de voies, incluant parties droites, courbes, aiguilles, etc.

Change: Operations pour changer les voies existantes par ex. symétrie, rotation, déplacement,
¢lévation

Draw: Ajouter des objets de base tels que lignes, formes, texte

Manage: Gestion particulieére de vos structures ou matériels roulants, ajouter de nouveaux
¢léments de voies avec le concepteur, faire rouler les trains

Options: Changer les réglages de 1’application ou du réseau
Macro: Enregistrer ou lancer des macros
Windows — Sélectionne la fenétre active, réouvre la fenétre map si elle est fermée

Help - Acces a I’aide
4. DETERMINATION DE LA TAILLE ET DE L’ECHELLE

La premiére chose a faire pour commencer un nouveau plan est de choisir les unités. Cela se fait
par les options du réseau Options>Preferences

Il Preferences E|

Angles |+ Palar & Cartesian

Uritz | English & Mehic Cancel
Length Farmat | 999,939 j Help

Min Track Length 3000
Connection Digtance [1.000
Connection Angle [S.000
Tumtable &ngle 0000
Max Coupling Speed 1000

v Balloon Help

Drag Distance (20
Drag Timeowt [S00
Min Grd Spacing 320
Check Point 100

On Program Startup |+ Load Last Layout
" Start Mew Layout

Cliquer dans la case metric afin d’utiliser le systeme métrique comme unité de base. Nous
verrons les autres options plus loin...
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Cliquer sur OK

Ensuite, il faut entrer les dimensions disponibles de votre emplacement et de sélectionner
I’echelle (N, HO, O, etc.) ? Cela se fait par les options du réseau Options>Layout

I layout Options

Room'width (550000  Height [300000 R
Layout Title | Cancel
Subtitle |
Scale | 0 (1/48.0] v|  Gauge | Standard [(31.8mm) ~| _teb |
Min Track Radius [21.280  Maw Track Grade [3.000

Entrer les dimensions maxi. Ici 550 cm par 300 cm. Entrer le nom de votre réseau et choisissez
I’échelle et I’écartement. Ici, échelle O et écartement standard 31,8 mm.

Cliquer sur OK

5. SELECTIONNER DES ELEMENTS DE VOIE

Pour ce premier réseau, nous alons utiliser des rails JEP a traverses métalliques. Vous devez tout
d’abord charger cette base sur votre PC.

Le fichier « zip » est disponible sur mon site internet a I’adresse suivante
http://train.jouet.perso.neuf.fr/ rubrique « téléchargement ».

Ou directement : http://train.jouet.perso.neuf.fr/JEP.zip

Vous devez décompresser le fichier dans le répertoire C:\Program Files\XTrkCAD
4.0.3a\share\xtrkcad

Pour utiliser ensuite ces fichiers, aller dans File>Parameter Files>Browse...

Load Parameters
Fiegarder dans : ‘L’f} params j |‘j< v
ﬁaccurail.xtp ;j AtlasTrueTrk.xtp ;} Inpicco.xtp Ej LifeLike-h
- ﬂamb-n.xtp ﬁjBachmannEZ-HO.xtp ﬁjfl-profl‘xtp ﬁlemaHO‘x
Mes Elncuments ﬂarnold.xtp ﬂj BachmannEZ-M.xtp £j gargrv-o.xtp ﬁj LionelFas
TEEEE ﬂatlSSho.xtp ﬁ]bach-n.xtp ﬁ]hornbySr.xtp ﬁ]LiDnEFO-'
'[' ﬂatlloﬂhn.xtp ﬁjbr.xtp ﬂjhubnerl Jxkp ﬁjme—ho.xt
ﬂatlascho.xtp lit| ctipanel <tp laiel JEP_Arcessnives,xtp | me-n.xtp
Bureau ﬂatlascn.xtp ﬁjdpm-ho.xtp ﬁjJEP_O.xtp ﬂjlllil ki
ﬁatlaseho.xtp lgz#|dpm-m. b al.xk sl mp-n. et
ﬁatlasen‘xtp ﬁjeu.xtp aJUuEFHO.XtD ﬁjmrkhucde
ﬁatlasnss.xtp s Fallerho. xkp ﬁkatn-hn.xtp njmrkh 1.t
Mes documents - Y
ﬁatlasn.xtp ﬁ]FastTrack_n.xtp ﬁkato-n.xtp [iiz| rrkinbioc, T
- ﬁatlasoZrai\.xtp ﬁjFastTrack—HO.xtp ﬁkato-n-DblTrk‘xtp ﬁjmrkh thotk.,
b-ilj_g ﬂntlasTrueTrackN‘xtp ﬁ]ﬂ-model.xtp ﬂ\gb.xtp ﬂjlllle thorm
Poste de traval |, 1 s &
.i% Mam du fichier : |JEP-D-MetaI.xtp ﬂ Oluwrir | 7!
Favoris réseau  Fichiers de type © |Parameter files j Annuler
I Ouvrir en lecture seule
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Choisissez JEP-O-Metal.xtp puis ouvrir, puis renouveler 1’opération avec JEP_Accessoires.xtp.
Cliquer sur OK

Vous pouvez sélectionner autant de fichier que vous le souhaitez mais pour des raisons de
facilité¢ d’utilisation, nous vous conseillons de supprimer les fichiers non utilisés en les
sélectionnant et cliquant sur “Unload”

Remarque importante : Le fichier paramétre (Barre objets) affiche uniquement les
bibliothéques correspondant I’échelle et I’écartement choisi au départ dans
Options>Layout.

Par exemple si vous selectionner aussi le fichier JouefHO.xtp, les rails Jouef ne seraont pas
afficher dans la Barre objets car ils ne sont pas dans la bonne échelle/écartement.

6. PLACER LES ELEMENTS DE VOIE

La Barre objets vous montre les ¢léments de voie bruts tels qu’utilisables. Vous pouvez
sélectionner le premier élément de voie qui vous intéresse en cliquant dessus (un clic gauche).

Pour le mettre sur le plan, cliquer a I’emplacement voulu sur le plan. L’¢élément apparait alors en
bleu. Tant qu’il est en bleu, vous pouvez le bouger n’importe ou par un simple clic a I’endroit
voulu. Il se positionne sur le coté gauche du curseur (souris). Pour I’orienter différemment
(rotation), appuyer sur la touche shift et faites un clic droit. Vous pouvez alors sélectionner
I’angle de rotation voulu.

Pour cet exemple, choisissez un rail droit DE10 33,7 cm. Placer votre souris en X= 80 et Y=140,
puis clic gauche.

** Unnamed Trackplan® - XTrackCAD(4.0.3a) E@

Fle Edit Wiew Add Change Draw Manage Options Macro Window Help
DE®E %8 & 6@ et Bl L0 50 880D |2 W |HEMMY 66 F00 8807 A6 - H-AD
dq w 1: Main -1(2|3 Z18/9|1

[ ETH |

0.0

‘ ; ==
0.0 1.0 20 3.0

[Zoom: 121 [%:100.000  [v:140000  [Left dragto move, right drag to ratate, press Space of Retum ta fix tiack in place or Esc to cancel
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Rappel : La barre d’état en bas de 1’écran vous indique la position de votre curseur.

Une fois I’élément en place, appuyer sur la touche ESPACE afin de valider la position.
L’¢lément de voie apparait alors en noir et les extrémités et le rails central apparaissent :

* Unnamed Trackplan® - XTrackCAD(4.0.3a)

Fle Edit Wiew Add Change Draw Manage Options Macro Window Help

OIS 3] 8 |& &) & | @ | 50| % | |02~ O 5B B ID|| W) |5 i M 3|9 @@ 2|, 5| 8B M7 A El- A D
W 1 Man -|1(2|3| |5/6|7|8(9|

\ S e [EauE] | |
— ——

10| Ll

0.0 =il
T T T

0o 10 20 an j—

[Faom: 121 [}:170.000  [7: 140000 [Select back to describe

Pour continuer, nous allons ajouter un élément courbe. Sélectionner le rail courbe CE10 : faites
le glisser en maintenant le clic gauche appuyer depuis la barre d’objet jusqu’a I’extrémité gauche
du rail droit déja en place :

=" tutorial.xtc* - XTrackCAD(4.0.3a)
File Edit Wiew Add Change Draw Manage Options Macro ‘Window Help

LR & & & & @ SN %E F @

S| | |'|:Main J123 7891

/I:
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Si I’élément ne se positionne pas dans la bonne direction, appuyez sur shift et clic gauche en
méme temps :

2" tutorial.xtc® - XTrackCAD(4.0.3a)
File Edt Wiew Add Change Oraw Manage Options Macro  Window  Help

L& B & & & & "R B E L8 E

‘r“lw\ *.! |1:Main ﬂlza 2

..) ﬂ I-.

Tant qu’un ¢élément apparait en bleu, vous pouvez le faire tourner avec shift+clic gauche autant
de fois que vous le souhaitez...

Valider avec la touche ESPACE ou bien renouveler I’opération pour ajouter un deuxi¢me
¢lément puis ainsi de suite jusqu’a faire un demi cercle:

Y| (¥ [ 1 Main =123 78|91

| — . I
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Si un élément ne se place pas exactement sur 1’extrémité de I’élément déja en place, vous pouvez
le faire glisser jusqu’a cette extrémité tant qu’il apparait en bleu.

Note : le logiciel détecte I’extrémité de 1’élément déja en place (2 quelques cm prés)

Essayer maintenant de positionner les éléments DE10 et CE10 pour faire la figure suivante :

Selectionner ensuite un % DE10 :

Puis continuer avec trois courbes CE10 et deux droits DE10:

http://train.jouet.perso.neuf.fr/ 8/16




XTrackCAD Guide d’utilisation Ed 2011

Finir avec un 1/4DE10 :

Aie : les éléments ne se raccordent pas !!
Heureusement, XTrackCAD, comme pour les éléments JEP, permet une souplesse dans les
raccordements !

Sélectionner le bouton « connect two tracks » dans la barre d’outils:

o | of |2k | 37 | | 13

|I:|:|nneu:t b trau:ks|

Puis faites un clic gauche sur les 2 extrémités a raccorder : ¢’est magique !

“ Yutarial eie® - X TrackCAIN(A. 0, 3a) E

Fin B8 Vew Add Change Draw Manage Optiorn Maoo  Window reh
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Mais pourquoi est-ce faisable ? Tout simplement parce que le logiciel autorise un certain jeu
entre les jonctions des éléments et ce jeu est paramétrable. En effet, on autorisera plus de
décalage sur un réseau type jouet que sur un réseau « fine scale » !

Pour paramétrer le décalage possible, cliquer sur Options>Preferences :

M Preferences

Angles |+ Palar & Cartesian

Unitz |~ English = Metric Cancel
Length Format | 599,999 j Help

Min Track Length [3.000
Connection Distance [1.000
Connection &ngle [5.000
Tumtable Angle 0000
Max Coupling Speed 100

[v Balloon Help

Drag Distance (20
Drag Timeout [5S00
Min Grd Spacing [2
Check Paoint 10

On Program Startup |+ Load Last Layout
" Start Mew Layout

« Connection distance » et « Connection angle » définissent en mm 1’écart toléré entre 2
¢léments a relier. Dans 1’exemple ci-dessus, on autorise 1 mm d’écart et 5° d’angle. On peut aller
facilement jusqu’a 3 ou 4 mm avec des rails JEP a traverses métalliques. Le logiciel n’accepte
pas d’écart supérieur a 6,35mm (1/4°).

Nous allons maintenant insérer des aiguilles dans notre circuit.
Pour ce faire, il faut déconnecter deux portions de voies en utilisant le bouton « split a track »

I
AN Y g Y egl V)

Split a track,
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Cliquer sur ce bouton puis sélectionner les jonctions entre les 2 éléments a séparer :

On peut maintenant déplacer toute un partie de noter circuit. Pour cela, il faut sélectionner la

ﬁartie a déﬁlacer. On utilise le bouton « select objects » :

B D) ||| H |

EHIE

En cliquant sur ce bouton, vous pouvez ensuite sélectionner un objet du plan en cliquant dessus
(simple clic gauche) ou sélectionner un groupe d’objet en appuyant sur la touche « shift » et un
clic gauche.
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Si vous faites ce shift+clic droite sur la partie gauche du réseau, vous selectionnerez toute cette

partie (qui apparaitra alors en rouge) :
** tutorial.xtc* - XTrackCAD(4.0.3a)

File Edit Wiew Add Change Draw Manage Options Macro window Help
S [®) & |8 &) & || 55| %] | F4f- 8- =« 78 ED || W |8 P (8 E) #2378 S5 |- A [~ |A M
S W [1:Man -|112|3| |5/6|7/8|9|1

I I
10 | |
0.0
T T T
00 10 20 30
[Zoom: 12:1 ‘X 79.000 |Y : 119,500 ‘Tumuul (9): Laper=1.JEP O Rail CE10 Dia 117 Rail courbe Section 36°

Pour déplacer toute la sélection, cliquez et maintenez « shift »+clic gauche sur la partie rouge et
faites la glisser vers la droite en conservant I’alignement (pour cela, regardez la coordonnée Y
dans la barre d’état)

**tutorial.xtc® - XTrackCAD(4.0.3a)

Flle Edit Wew Add Change Draw Manage Options Macra Window Help
S [3) & || &) oo B | £4 -0 =78 2D |2 %[ D 8 #0227 8B M ARO[ A D
dq w 1: Main -1(2|3 5 Z18/9|1

I I
wi C 7
0.0
T T T
0.0 1.0 20 3.0
[Zoom : 121 [+ 37.000 v : 161.500 [Select track to descibe
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Vous pouvez maintenant ajouter deux aiguilles entre les trongons séparés : sélectionnez une
aiguille gauche AGE10, faites la glisser sur le trongon choisi. Si elle n’est pas orientée
convenablement, faites « shift »+clic gauche jusqu’a obtenir la bonne orientation :

BN = —

= puis ESPACE :

Faites de méme sur la partie supérieure du circuit :

** tutorial.xtc* - XTrackCAD(4.0.3a)
File Edit Wiew Add Change Draw Manage Options Macro window Help

DEE & & @ 5 8l F8-0-f8ED S W WX 88 &0 &R0 A-Q-HEH-AD
S W] [ en -l 1{2|3] |5|6|7(8/9|1

1

i I [
f N [x]
10 | |
|

0.0

T T T

alls] | 1.0 20 30

[Zoom: 121 \X : 36.500 7 : 177.000 \Lefl drag to move, right drag to rotate, press Space of Return to fik track in place or Esc to cancel

Il faut maintenant déplacer a nouveau le trongon droit pour le raccorder. On va utiliser la
fonction « join two tracks » : pour cela, il faut d’abord sélectionner tout le trongon a déplacer
(comme précédemment en utilisant le bouton select objects puis en faisant « shift » + clic
gauche). Ensuite, appuyez sur le bouton « join two tracks » puis faites « shift »+clic gauche
d’abord sur le trongon a déplacer:
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e

un point rouge apparait sur I’extrémité a déplacer, puis encore « shift »+clic gauche sur I’autre
extrémité a raccorder. Lors de ce second « shift »+clic gauche sur la partie fixe a raccorder,
I’ensemble a droite se déplace :

** tutorial.xtc* - XTrackCAD(4.0.3a)
File Edit Wiew aAdd Change Draw Manage Options Macro window Help

OIS |3 &R &) & | @) 5| R | £8 - O == 7 8B ID| | W [ D 88 |F 2 27 &2 M- A Q- EA - A M

<, W [1Man -|112|3| |5/6|7|8|9|1

} — - hap. [
1.0 L
0.0 =i
T T T
alls] | 1.0 20 30 L
[Eoom: 121 [%:44800  [r:191600  [Select tack to descibe

Attention, en partie inférieure, les éléments ne sont pas raccordés ! Il faut les raccorder en
utilisant comme précédemment la fonction « connect two tracks »

AN OE Y- g e

[Conhect two tracks|
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** tutorial.xtc* - XTrackCAD(4.0.3a)

File Edit Wiew Add Change Draw Manage Options Macro window Help

S |[®) &R &) & || 5| ] | £4 -0 == 7 8B D |8 W[ D 88 #0237 &2 M- A Q- EA - |A M
S W [T Man -|112|3| |5/6|7|8|9|1

1 —— - ETH

0.0 —
T T T
00 10 20 30 EAd

[Eoom: 121 [%:81800  [r: 16500 [Select second EndPairt to connect

Vous pouvez compléter avec des voies courbes CE10 :

** tutorial.xtc® - XTrackCAD(4.0.3a)

Fle Edit Wiew Add Change Draw Manage Options Macro Window Help
OIS |3 & || &) & @) 50| & | |- O x| B B ID| | W) | i M |9 @@ 2|2 e BB M7 A A A D
& (M [uMan  AI112|3] |5/6(2(8/9|1D

| ——— ] Eoet |

0.0

T
00 | 10 20 30
[Foom:121  [K:10800  [v:37500  [Thers are no unconnected end points for this track

Pour finaliser, faites « Edit — Deselect All » puis « View - Redraw all » ...
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“ tutorial.xtc™ - XTrackCAD{4.0.3a)

ile B[ view Add Change Draw Manage

:I IIndo Chrl+Z 3
Reda Chrl+R, |

SRt Chrl4s L
Copy Chrl4+C

_ | Paste el |

T Delete Chrl+D -

Mave To Current Laver

=" tutorial. xtc* - XTrackCAD{4.0.3a)

Select Al ChElShiFE+4 File Edit BEES add Change Draw  Manage
Select Current Layer K | Zoom In Crl+ m
200 L4
Invert Seleckion €, W ZoomOut Chrl- B
Select Stranded Track, — -
Redraw Chrl+L
Tunnel Ctrl+Shift+T Redraw Al Ctel+-Shifk+L
Above Ctri+-Shift+B =
Below Chrl-Shift-+ Enable SnapGrid
] Show Snaptarid
Thin Tracks Chri+1 Change Grid,..  Chrl+Al+G
Mediumn Tracks Chrl42
Thick Tracks Ctrl+3 Tool Bar ¢

Et enregistrer votre réseau.: « File - Save as... »
Il y a bien d’autres fonctions disponibles, notamment pour faires des passages supérieurs ou
inférieurs (« elevation »), pour créer des rails spéciaux, et aussi pour simuler du matériel roulant

et faire circuler les trains mais ce sera pour la prochaine legon... !!

A bientot.
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